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This manual applies to OpenLAB CDS ChemStation Edition Software (version 
C.01.03 and later until superseded) and Agilent 6100 Series LC/MS 
instruments.

Where to find more information

Online Help Use online Help for in-depth information beyond what is shown 
in this Quick Start Guide. Display online Help in any of the following ways:

• Click the Help button in the toolbar.

• Select Help Topics from the Help menu.

• Click the Help button on most dialog boxes to show task-specific help.



What’s New in C.01.06?
User Guides Besides this Quick Start Guide, the following guides are shipped 
with your system and are also available in PDF format on the installation disk.

• Agilent 6100 Series Quadrupole LC/MS Systems Familiarization Guide

• Agilent 6100 Series Quadrupole LC/MS Systems Concepts Guide

• Agilent 6100 Series Quadrupole LC/MS Systems Installation Guide 

• Agilent 6000 Series LC/MS Maintenance Guide 

What’s New in C.01.06?

• 5 kDa/sec and 10 kDa/sec Fast Scan speeds on G6120B and G6130B with 
step size of 0.2 Da. Multiple Fast Scan speeds, such as 5k Da/sec and 10k 
Da/sec., are now supported for Data Acquisition.

• 5 kDa/sec, 8 kDa/sec, and 16 kDa/sec Ultrafast Scan speeds on G6150B 
with step size of 0.2 Da. Multiple Ultrafast Scan speeds, such as 5 kDa/sec 
and 8 kDa/sec or 8 kDa/sec, and 16 kDa/sec are now supported for Data 
Acquisition.

What's New in C.01.03?

• Support for Windows 7 32-Bit and 64-Bit with Service Pack 1.

• Support for Fast Scan on G6120B.

• Support for Fast Polarity Switching on G6120B (hardware upgrade 
required).

• Support for ESI with Agilent Jet Stream Technology on G6130B (hardware 
upgrade required).

What's New in C.01.02?

• Support for Windows 7 32-Bit and 64-Bit.

• Support for 6100 Series LC/MS on OpenLAB CDS ChemStation Edition.
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Configuration Diagrams

1100/1200/1260/1290 Series LC
Configuration Diagrams

1100/1200/1260/1290 Series LC
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Configuration Diagrams

LC Cabling
LC Cabling
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CAN bus cable

AC power
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ChemStation Views

LC Cabling
ChemStation Views

The LC/MS ChemStation software consists of several views. Click one of the 
view buttons in the lower left corner of the screen, or from the View menu, to 
change to a different view. 

Method and Run Control View Allows you to set up methods and adjust 
instrument parameters to inject samples and acquire data one sample at a 
time or in automated sequences. See the next page for more information.

Data Analysis View Allows you to perform various data evaluation tasks on 
chromatograms and spectra, such as integration, quantitation, checking peak 
purity, deconvolution, and report generation. See page 9 for more information.

Report Layout View Allows you to design custom report templates to use with 
the data generated by your ChemStation. See page 12 for more information.

Verification (OQ/PV) View For use by Agilent service engineers to determine 
if your system is operating in a predictable manner. This view is useful to 
show Good Laboratory Practice (GLP) compliance, which some government 
agencies can require. See page 14 for more information.

Diagnosis View Allows you to run tests to diagnose instrument problems and 
access information on how to resolve these problems. The early maintenance 
feedback (EMF) feature can notify you when it is time to perform system 
maintenance before a problem occurs. See page 16 for more information.

MSD Tune View In this view, you can calibrate your LC/MS automatically. You 
can also set MS parameters manually for specific types of molecules. See 
page 17 for more information.
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ChemStation Views

Method and Run Control View
Method and Run Control View

NOTE
The user interface for Method and Run Control can be configured in two ways during 
installation. See Agilent 6100 Series Single Quad LC/MS System Installation Guide for 
information on installation and configuration.
If your instrument is configured with the Classic user interface, then see ChemStation 
online Help and these manuals on the ChemStation disk:
• Agilent 6100 Series Single Quad LC/MS Systems Quick Start Guide 
• Agilent 6100 Series Quadrupole LC/MS Systems Familiarization Guide 
• Agilent 6100 Series Quadrupole LC/MS Systems Concepts Guide 

Message Line
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Tool Set Selection: 
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Top Toolbar

Online Plot

Method Overview

File List

Method Sequence

Data 

Analysis
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MS, FIA
Disk Space
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ChemStation Views

Method and Run Control View
Status and Run

Bars: Instrument

Control Tab

Right-click the Method icon to see the following commands: 
Run Time Checklist, Method Information, Edit Entire Method, Method Audit 
Trail, Print Method, and Help.

System Diagram Each icon of the system diagram represents one component or module of your 
system. Click on an icon if you want to edit the method parameters or go to the 
online Help for that particular component.

Start 
Sequence

Stop 
Sequence

Method

Pump & Solvents ColumnInjector Detectors
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ChemStation Views

Method and Run Control View
Single Sample

Tool Set

This toolset allows you to work on methods and run an analysis for a single 
sample. Move the cursor over a button to view a description of it.

Sequence

Tool Set

This toolset allows you to work on sequences and run automated analyses of 
multiple samples. Move the cursor over a button to view a description of it.

Flow Injection

Analysis (FIA)

This toolset allows you to inject multiple samples directly into the detector, 
which lets you bypass the chromatographic column. The results are sent to a 
single data file. FIA can be used for method development or for applications 
that do not require chromatography.

Click the Single Sample icon to display this toolset.

Click the Sequence icon to display this toolset.

To enable FIA from the system diagram:

• Click the FIA icon.
• Select Edit FIA Series.
• Mark the Enable FIA Series in Method option and edit the 

FIA Table.
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ChemStation Views

Data Analysis View
Data Analysis View

The various tool sets available in Data Analysis View are shown on the 
following pages. You can view a description of a button by moving the cursor 
over it.

Display Graphics 
Tools

Tool Set Selection

Cursor Tools

Signal View Selection

DAD Signal

LC/MS Signal

Message Line

Navigation Tools

File List
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ChemStation Views

Data Analysis View
Common Tool Set This toolset is always present in Data Analysis view.

Graphics Tool Set Allows you to manipulate the graphic display.

Integration Tool Set Allows you to perform integration and reporting tasks on 
a chromatogram.
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ChemStation Views

Data Analysis View
Calibration Tool Set Allows you to perform calibration tasks for quantitation.

Signal Tool Set Allows you to work graphically with the UV or MS signal.

Purify Tool Set Allows you to work graphically with your purification data.

Spectral Tool Set Allows you to perform spectral evaluation tasks.

Deconvolution Tool Set Allows you to transforms mass spectra from 
multiply-charged ions into a calculated molecular weight.
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ChemStation Views

Report Layout View
Report Layout View

Report Layout 

Tool Set This toolset is present in the Report Layout view. Move the cursor 
over a button to view a description of it.

Tips • Edit or create a report layout as described in the online Help.

• To test your report layout, select a calculation technique from the 
drop-down list box to define how the results are calculated. 

• Load a data file. The results are loaded into the report template using the 
selected calculation.

• Select File / Add to Report Styles to add your completed report template 
to the list of available report styles. Now you can use your customized 
report within a method.

New Section Menu

Message Line

Report Template Calculation Technique

Report Section
Insertion Triangle
Click a blue triangle to activate 
the new section menu (triangle 
turns red)

Toolbar
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ChemStation Views

Report Layout View
Sample Report Layouts (in \CHEM32\REPSTYLE)

Template Description

SIMPLE.FRP Includes a chromatogram and calibration curves per calibrated 
compounds.

NESTED.FRP Shows how to nest subsections.

SPECTRA.FRP Shows how to include spectra.

PURITY.FRP Shows how to include peak purity data.

ESTD.FRP Uses the same elements as the standard ESTD reports so you can 
customize your external standard reports.

AREAPCT.FRP Uses the same elements as the standard area percent report so you can 
customize your area percent reports.

Print Preview button
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ChemStation Views

Verification (OQ/PV) View
Verification (OQ/PV) View

The Verification (OQ/PV) view lets Agilent service engineers test whether your 
analytical instruments and the ChemStation software are operating correctly 
according to predefined performance criteria.

Operation Qualification (OQ) Operation Qualification is the documented 
verification that the equipment-related system or subsystem performs as 
intended throughout representative or anticipated operating ranges.

Message 
Line

Start/Stop Run

System 
Diagram

Verification Toolbar

Task 
Selection 
Menu
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ChemStation Views

Verification (OQ/PV) View
Performance Verification (PV) Performance Verification is the documented 
verification that the process and or the total process-related system performs 
as intended throughout all anticipated operating ranges.

System Diagram Each icon of the system diagram represents one component 
or module of your system.

Verification Toolbar The Verification toolbar is displayed when you select 
Show Top Toolbar from the View menu. Move the cursor over a button to view 
a description of it.

Available Tests The following verification tests are supplied with your 
ChemStation software for use by an Agilent service engineer. Refer to the 
online Help for more information on these tests.

• VWD Wavelength Accuracy

• Intensity

• Holmium

• Temperature Accuracy

• Noise, Flow, Temperature

• DAD Wavelength Accuracy

• Injector Precision

• Detector Linearity/Carry-over

• Injector Linearity

• Gradient Composition
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ChemStation Views

Diagnosis View
Diagnosis View

This view allows you to carry out diagnostic and maintenance activities on 
your system.

Diagnosis Toolbar The Diagnosis toolbar is displayed when you select Show 
Top Toolbar from the View menu. Move the cursor over button to view a 
description of it.

Instrument 
Panel

Symptoms Cause 
Information Pad

Possible Causes

Variables Display

View 
Selection

Message Line

Task 
Selection 
Menu
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ChemStation Views

MSD Tune View
MSD Tune View

MSD Tune Toolset

This toolset is present in MSD Tune view.

Title Bar

View Selection

Message Line

MSD Tune Toolbar Status Bar

File Selection

Load an LC/MS tune file. Calibrate the mass axis.

Save the current tune file. Change spray chamber 
parameters.

Generate a profile and scan 
report.

Edit LC/MS parameters for 
manual tuning.

Autotune the LC/MS and print a 
tune report.

Acquire multiple scans and send 
results to data file.
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Basic Operation

Start up and shut down the system
Basic Operation

Start up and shut down the system

Task Instruction Comment

To start up the system 1 From the Method and Run Control 
view, click the  button on the 
system status bar. When you move 
mouse over the button, if system is 
currently idle, it turns green.

2 Set up the LC conditions (pump, 
column heater, and detector).

3 Set up the LC/MS spray chamber 
conditions as described in the MSD 

Spray Chamber dialog box topic in 
the online Help.

Allow 15 minutes for the system to warm 
up.

This procedure assumes that the 
system is under vacuum and the LC 
and LC/MS are properly connected. It 
also assumes that the liquid flow path 
is properly set up.

To put the system in Standby Mode 1 Flush the system with pure mobile 
phase to ensure that the flow path is 
clear of buffers. This prevents the 
nebulizer from plugging. A plugged 
nebulizer can cause a high back 
pressure, which can damage the LC 
flow cell.
It is good practice to flush the flow 
path (including the column) for 5 to 10 
minutes with a mobile phase without 
buffers such as 50:50 
water/acetonitrile.

2 Click the  button on the system 
status bar. All modules are set to 
standby mode (indicated by the gray 
color in the system diagram).

Put the system in standby mode 
overnight or whenever you are not 
analyzing samples for an extended 
time. The standby state for the LC/MS 
leaves the nebulizer and drying gas on 
at low flow.

Standby for the LC/MS is: 
• 20 psi for the nebulizer, 
• 3 L/min for drying gas, 
• 300 °C for drying gas temperature,
• 325 °C for the APCI vaporizer, if 

present
• the MS stream selection valve is 

set LC to Waste.
For Agilent Jet Stream source:
• Sheath temp 100°C
• Sheath gas flow 2.2 L/minute
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Basic Operation

Tune the LC/MS
Tune the LC/MS

When the LC/MS is used as a detector for the LC, a mass spectrum is 
associated with each data point in the LC chromatogram. To obtain high 
quality, accurate mass spectra, optimize the LC/MS to:

• Maximize sensitivity 

• Maintain acceptable resolution

• Ensure accurate mass assignment

Tuning is the process of adjusting LC/MS parameters to achieve these goals. 
After the LC/MS parameters have been optimized, they must be saved in a 
tune file (.tun). This tune file is then specified in the method that is used to 
acquire data for your samples.

Frequent tuning, whether automated or manual, is not required. Once tuned, 
the LC/MS is stable. Tuning is needed no more often than monthly, weekly at 
most.

Wait 4 hours after pumpdown before tuning or operating your LC/MS. The 
analyzer takes about 11 hours to reach thermal equilibrium. Tune files that 
are created or data that is acquired before the LC/MS is at thermal 
equilibrium can have incorrect mass assignments and other inaccuracies.

Task Instructions Comments

To use Autotune 1 From the MSD Tune view, select 
Autotune from the Tune menu or click 
the Autotune toolbar button.

2 Review the tune report that is printed 
automatically when tuning is 
completed.

Use autotune for automated 
adjustment of the LC/MS 
performance.
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Basic Operation

Tune the LC/MS
To use Check Tune 1 Select Check Tune from the Tune 
menu.

2 Review the Check Tune report. 
Adjustments are suggested for values 
that are outside of acceptable ranges.

Use Check Tune to determine quickly 
whether the LC/MS is correctly tuned. 
It performs a single profile scan of the 
tune masses and compares the peak 
widths and mass axes with target 
values.

To use Manual Tune 1 Select Manual Tune from the Tune 
menu.

2 Set the desired mass resolution 
(adjusting width gain and width 
offset).

3 Calibrate the mass axis (adjusting 
mass gain and mass offset).

4 Optimize the ion transmission through 
the source ion optics (fragmentor, 
skimmer(s), lens 1, lens 2, and 
octopole peak).

5 Adjust the signal strength (setting iris 
and adjusting the multiplier gain).

Fragmentor and gain are method 
parameters. The fragmentor affects ion 
transmission and fragmentation. For 
more information, see the online Help.

Use Manual Tune when you want to:
• Achieve maximum sensitivity by 

sacrificing some resolution
• Tune specifically for the very low 

end (<150 amu) of the mass range
• Tune with a compound other than 

the standard calibrants

Task Instructions Comments
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Basic Operation

Acquire LC/MS Data
Acquire LC/MS Data

Modes of Acquisition

There are three modes of acquiring data:

• Running a method for a single sample

• Running a sequence for multiple samples

• Running an FIA series

Note the following about acquiring data:

• All three acquisition modes require an appropriate method.

• Samples can be injected either manually or with an ALS.

• Always start a run from the software.

• An FIA method cannot be used in a sequence but multiple FIA methods can 
be run sequentially.
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Basic Operation

Acquire LC/MS Data
To edit a method and start a run

Once you know the acquisition mode that you want to use, you must set up an 
appropriate method. Methods are set up in the Method and Run Control view.

Instructions Comments

1 Activate the single sample toolset by clicking the 
button on the toolbar.

2 Load a method by selecting Method / Load Method 
or by clicking the button on the toolbar and 
selecting a method from the list.

3 Click the button to begin editing the method. You 
can also begin by selecting Edit Entire Method from 
the Method menu or by right-clicking the icon 
on the Run Control Bar.

4 Select the method sections you want to edit (select all 
sections to become familiar with the method 
parameters that are available) and click OK.

A series of dialog boxes is displayed, 
which allows you to set up your 
method and instrument parameters.

5 Add any method comments you want to appear on 
your reports.

6 Set up the instrument parameters, such as pump, 
injector, DAD or VWD, column thermostat, MS 
signals, and MS spray chamber.

7 Set up the Data Analysis parameters, such as signal 
details, integration events, report parameters, 
instrument curves, calibration curves, calibration 
table, and ion parameters.

8 Complete the Run Time Checklist.

Click the Help button on any of the 
method dialog boxes for descriptive 
information on the items available in 
each.

9 Save the method using a different name. Select 
Method / Save Method As or click the button on 
the toolbar.

Once you are familiar with the options 
that are available, use the system 
diagram menus for quick access to 
particular method parameters.

10 When you are ready to begin a run, click the Start 
button.
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Deconvolution

To deconvolute a mass spectrum
Deconvolution

Deconvolution is an optional process (additional license required) that 
transforms mass spectra from multiply-charged ions into a calculated 
molecular weight.

To deconvolute a mass spectrum

Instructions Comments

1 In the Data Analysis view, load an electrospray MS 
data file. The TIC is displayed. 

2 Generate the MS spectrum that you want to 
deconvolute. (Select the Spectral task tool set and use 
the spectrum selection tools to pick the spectrum of 
interest). 

3 Click the Enter Deconvolution Tool button to 
set up the deconvolution display area.

4 When the spectrum is displayed, click the 
Label Ions button to locate masses to be 
used in deconvolution. 

These operations are performed on 
data acquired in full scan mode.

5 Examine the ions that were found. Very noisy data or 
data with unresolved regions often need special 
settings to find ions. 

6 Click the Edit Deconvolution Parameters 

button to change any of the parameters.

You can use the Ion Label 

Options button to optimize 
the set of ions found.

7 Click the Run Deconvolution button to begin 
the deconvolution process. 

Once the deconvolution is done, the 
components are displayed in the 
upper right window. The charge states 
are displayed in the lower right 
window.
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Deconvolution

Deconvolution Report
Deconvolution Report

The Deconvolution report contains summary information about each 
component selected, along with detailed information on how each peak in a 
component contributes to the molecular weight of the component. In the first 
part of the report, the components are ranked by percent relative abundance, 
which is useful for estimating the percent of impurities.

The actual molecular weight can differ from the computed molecular weight 
even if the data fit a Gaussian curve perfectly, due to other errors such as 
errors in mass axis assignment or unresolved chemical impurities.

The Deconvolution software is optional and is part of the OpenLAB CDS 
ChemStation C.01.xx or M8363AA (ChemStation C.0x) Bioanalysis Software 
package.

8 Select specific components from the Component list 
to look at individual components or groups of 
components. 

Optionally, click the Preview 

Deconvolution Report 
button 
or click the Print Report 
button.

9 Optionally, select components from the 
Component List box and then click the 
Delete Components button. 

10 Repeat the process. 

This action removes the peaks for the 
selected components from the original 
spectrum. You can then continue with 
step 4 (previous), using this new 
spectrum. 

Instructions Comments
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Operating Tips
Operating Tips

• Back up your data and methods regularly to avoid loss of data in case the 
files are accidentally overwritten, deleted, or if a hardware problem 
develops with your disk drive.

• Put the system in standby mode overnight or whenever you are analyzing 
samples for an extended time.

• Verify that the tune file you are using is appropriate for your samples.

• Save Tune reports in an MS Logbook for future reference.

• Regular system maintenance can reduce problems. Keep a maintenance 
record.

• Use the Maintenance Logbook and EMF features in Diagnosis view to help 
you track when maintenance is needed and to keep an online maintenance 
record.

• Flush the sample path and clean the spray chamber, capillary tip, and spray 
shield daily or at the end of each shift. Check the foreline pump fluid level 
every week.

• The spray chamber vent hose must be connected to a lab vent that is used 
only for the source. The vent hose must be separate from the vent hose for 
the foreline pump. Otherwise, waste products can migrate into the spray 
chamber vent producing chemical noise.

• Samples must be filtered. If no chromatography is used, they must be salt 
and detergent-free.

• If a UV detector is available, use it in series with the LC/MS. Try to 
minimize chromatographic peak broadening by using low dispersion tubing.

• To avoid chromatographic band broadening, be sure that all tubing 
connections are free of dead volume. Use zero dead-volume (ZDV) fittings 
when possible.

• Use the following table as a guide to using SIM, condensed scan, and full 
scan acquisition modes.

Task Mode

Acquire electrospray data for samples containing large, 
multiply-charged analytes.

Full Scan

Analyze a mixture with unknown components (small molecules). Scan
Agilent 6100 Series LC/MS System Quick Start Guide 25



Operating Tips
Analyze a mixture with known components in unknown amounts 
(quantitate).

Scan or SIM

Identify the presence of a few known compounds at low levels 
within a mixture.

SIM

Use fast chromatography on 1.0-MHz LC/MS systems (G6120B, 
G6130B) without missing peaks.

Fast Scan

Use fast chromatography on 1.4-MHz LC/MS systems (G6150B) 
without missing peaks.

Ultra Fast Scan

Task Mode
26 Agilent 6100 Series LC/MS System Quick Start Guide



Troubleshooting Tips
Troubleshooting Tips

No peaks

✔ Verify that there is spray from the nebulizer.

✔ Verify that the capillary voltage is set correctly.

✔ In APCI mode, verify that the corona needle is installed.

In APCI mode, verify that the Corona Current setting is 2 μA or higher, and 
that the Corona Voltage is between 1500 and 5000 V.

✔ Verify that the MS system is tuned correctly.

✔ Verify that MS vacuum pressures are within normal ranges.

✔ Check the drying gas flow and temperature.

✔ Verify that the fragmentor is set correctly.

✔ Check if any error message indicates a problem with electronics.

✔ Verify that sufficient sample is present in vial.

Poor mass accuracy

✔ Recalibrate the mass axis.

✔ Verify that the ions used for tuning span the mass range of the sample ions 
and that they show strong, stable signals.

Low signal

✔ Check the solution chemistry. Verify that the solvent you are using is 
appropriate for your sample. Mixed samples can exhibit signal suppression 
of one or more components.

✔ Verify that the sample is fresh and has been stored correctly.

✔ Verify that the MS system is tuned correctly.

✔ Check the nebulizer condition.

✔ Clean the capillary entrance.

✔ Check the capillary for damage and contamination.
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Troubleshooting Tips
✔ Verify that the spray chamber parameters are set correctly, such as drying 
gas heater and nebulizer pressure.
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Troubleshooting Tips
Unstable signal

✔ Verify that the drying gas flow and temperature are correct for the solvent 
flow you are using.

✔ Verify that the solvent is thoroughly degassed. Do not use ultrasonic 
degassing with protein samples.

✔ Verify that the LC backpressure is steady; steady backpressure indicates a 
steady solvent flow.

High spectral noise

✔ Use appropriate mass filter values.

✔ Check the spray shape. Nebulizer can be damaged or incorrectly set.

✔ Verify that drying gas flow and temperature are correct for the solvent flow 
you are using.

✔ Verify that the solvent is thoroughly degassed. Do not use ultrasonic 
degassing with protein samples.

✔ Verify that the LC backpressure is steady; steady backpressure indicates a 
steady solvent flow.

✔ If you are using water as part of the mobile phase, verify that it is deionized 
(>18M).

Droplets, not spray, exiting the nebulizer

✔ Verify that the nebulizing gas pressure is set high enough for the LC flow 
being used.

✔ Check the position of the needle in the nebulizer.

✔ Stop the solvent flow and remove the nebulizer assembly. Use a magnifying 
glass to examine the end of the nebulizer for damage.
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Troubleshooting Tips
No flow

✔ Verify that the LC pump is on and there is sufficient solvent in the correct 
bottle.

✔ Verify that the solvent supply lines are free of air bubbles. Purge the 
appropriate pump channels, if needed.

✔ Check for LC error messages.

✔ Check for blockages. Repair or replace any blocked components.

✔ Check for leaks.

✔ Verify that the MS stream selector valve is set to LC to MSD.

Undesired fragmentation

✔ Fragmentor is set too high.

✔ Ionization is causing fragmentation (APCI vs. Electrospray).

✔ APCI temperature is too high.
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Safety Warnings
Safety Warnings

Intended Purpose

Use of the LC/MS in a manner not intended by the manufacturer is prohibited.

Safety Class

The LC/MS is a Safety Class 1 instrument. It has been designed and tested in 
accordance with IEC Publication 1010-1, Safety Requirements for Electrical 
Equipment for Measurement, Control, and Laboratory Use.

Stack Configuration

Placing the LC modules on top of the LC/MS is also inconvenient. It puts the 
solvent bottles and some LC controls out of easy reach and requires the LC 
stack to be disassembled and removed for LC/MS maintenance.

WARNING
Do not stack more than three LC modules of any kind on top of the LC/MS 

instrument. Stacking more than three LC modules is potentially unstable and 

dangerous.

WARNING
Use only Nitrogen as the drying and nebulizer gas. Air, oxygen, or other gases, 

when combined with solvents and high voltages in the spray chamber, can result in 

an explosion.

WARNING
Do not connect the LC/MS to a power source that is not equipped with a protective 

earth contact. You can create a shock hazard for the operator and can damage the 

instrument.

WARNING
Do not interrupt the protective conductor inside or outside the LC/MS or disconnect 

the protective earth terminal. You can create a shock hazard for the operator and 

can damage the instrument.
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Safety Warnings
WARNING
Do not adjust, maintain, or repair the opened instrument while it is connected to a 

power source. Only trained persons who are aware of the hazards involved can 

perform these operations.

WARNING
Before you perform maintenance on the electronics vent and turn off the LC/MS 

and disconnect the power cord. The power switch on the front of the LC/MS does 

not completely cut power to the instrument.
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Safety Warnings
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